Primi passi per creare un file PDF accessibile
B4 - 2010
di

Maria De Vizia Guerriero — Marina Rovetti



ABSTRACT

Lo scopo della nota tecnica & dimostrare l'importanza dell'accessibilita dei file PDF e
fornire un esempio concreto di realizzazione di un PDF accessibile utilizzando Adobe Pro,
l'unico strumento che permette di editare i file PDF e intervenire sulla loro accessibilita.
L'esempio verra fatto sul documento 2006-PR-09 dal titolo Manuale del sistema PUMA
(Publication Management), Versione 1.0 per I'amministratore contenuto all'interno della
Biblioteca Digitale PUMA (http://puma.isti.cnr.it); la comprensione e la lettura saranno

accompagnate dalla presentazione di immagini.
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Un documento €& una frase scritta in un qualche linguaggio che abbia un contenuto, una
struttura, una semantica e che puo essere in relazione con altri documenti. Un documento
elettronico € un documento la cui rappresentazione fisica € in forma di bit all'interno di un

sistema informatico (cit.).

ESEMPI DI DOCUMENTI

| documenti che possono essere resi accessibili non riguardano un solo formato e non
sono di una sola natura, infatti possono essere:
» testi debolmente strutturati: romanzi, racconti, poesie, saggi, articoli, eccetera.
» testi fortemente strutturati: elenchi telefonici, schede cliniche, manuali, eccetera.
* ipertesti: testi contenenti collegamenti interni che ne permettono una lettura non
sequenziale (vedi piu avanti).

* non-testi: immagini, schemi, progetti, fotografie, filmati, animazioni, eccetera.

Il tema dell'accessibilita € ampiamente dibattutto sia in sedi amministrative, sia in sedi
accademiche. La rete e le tecnologie internet rappresentano una nuova sfida e un punto di
approdo per chi ha problemi nell'accedere alle informazioni; per questo motivo gia da
diversi anni esistono alcuni standard internazionali e alcune leggi nazionali che
definiscono l'accessibilita per i sistemi informatici.

Le linee guida piu utilizzate, a livello internazionale, per quanto concerne il web sono le
WCAG (Web Content Accessibility Guidelines) redatte dalla WAI (Web Accessibility

Initiative, sezione del World Wide Web Consortium).

NORMATIVA ITALIANA

In ltalia, secondo le nuove realizzazioni e le modifiche apportate dalla Pubblica
amministrazione ai propri siti web, si deve tenere conto (pena nullita dei contratti stipulati)
della “Legge Stanca” (Legge 4 del 9 gennaio 2004), pubblicata nella Gazzetta Ufficiale il
17 Gennaio 2004), resa operativa col decreto attuativo di fine 2005. Il medesimo obbligo &

in carico, come specificato nell'art. 2 della legge, a

* pubbliche amministrazioni

 enti pubblici economici


http://it.wikipedia.org/wiki/Web
http://it.wikipedia.org/wiki/9_gennaio
http://it.wikipedia.org/wiki/Siti_web
http://it.wikipedia.org/wiki/Pubblica_amministrazione
http://it.wikipedia.org/wiki/Pubblica_amministrazione
http://it.wikipedia.org/wiki/W3C
http://it.wikipedia.org/wiki/WCAG

» aziende private concessionarie di servizi pubblici

» enti di assistenza e di riabilitazione pubbilici

» aziende di trasporto e di telecomunicazione a prevalente partecipazione di capitale
pubblico

* aziende municipalizzate regionali

* aziende appaltatrici di servizi informatici.

L'obbligo della applicazione della legge sussiste esclusivamente per i siti pubblici (o di
interesse pubblico) mentre, sempre nell'ambito pubblico, le disposizioni di legge non si
applicano ai sistemi informatici destinati ad essere fruiti da gruppi di utenti dei quali, per

disposizione di legge, non possono fare parte persone disabili.
La legge contiene altresi alcune definizioni:

» «accessibilita»: la capacita dei sistemi informatici, nelle forme e nei limiti consentiti
dalle conoscenze tecnologiche, di erogare servizi e fornire informazioni fruibili,
senza discriminazioni, anche da parte di coloro che a causa di disabilita
necessitano di tecnologie assistive o configurazioni particolari;

» «tecnologie assistive»: gli strumenti e le soluzioni tecniche, hardware e software,
che permettono alla persona disabile, superando o riducendo le condizioni di

svantaggio, di accedere alle informazioni e ai servizi erogati dai sistemi informatici.

La legge italiana - oggetto di accesi dibattiti sul suo reale peso nel favorire I'accessibilita
del web - si pone come obiettivo quello di dare attuazione al principio di uguaglianza
previsto dall'art. 3 della Costituzione Italiana e quindi garantire il diritto di accesso ai servizi
informatici e telematici della pubblica amministrazione e ai servizi di pubblica utilita da
parte delle persone disabili.
Le disposizioni della legge si applicano oltre che ai siti web, anche, secondo quanto
sancito dall'art.5, al materiale formativo e didattico utilizzato nelle scuole di ogni ordine e
titolo.

Un documento elettronico accessibile € utilizzabile da chiunque, incluse le persone
portatrici di disabilita.

Poiché non & possibile sapere a priori chi consultera un documento é necessario creare
documenti che possano essere fruiti da chiunque.

Normalmente i documenti non vengono prodotti con l'accessibilita in mente, e nemmeno

vengono utilizzati gli strumenti di base disponibili.



| documenti di testo in quasi tutte le occasioni non possiedono una struttura definita
utilizzando gli stili di paragrafo, non sono disponibili testi alternativi, sommari ed indici non
sono navigabili. Questo accade non perché non lo si possa fare, ma perché non si sa che
lo si pud fare e perché non si pensa all'accessibilita.
Per ottenere un documento elettronico accessibile, &€ necessario rispettare almeno alcune
regole basilari:
* Organizzare la struttura logica del documento utilizzando stili di paragrafo che
caratterizzino semanticamente i contenuti a cui vengono attribuiti.
* Garantire che il corretto ordine di lettura sia preservato anche quando il testo
eventualmente suddiviso in blocchi o in colonne venga presentato in modo

linearizzato.

* Fornire il documento di un sommario navigabile che permetta il collegamento
diretto ai corrispondenti contenuti e prevedere idonei collegamenti ipertestuali per il

ritorno all'indice o ai contenuti alla fine di ciascuna sezione.

* Dotare gli elementi informativi a corredo del testo, tra i quali note e relativi rimandi
e riquadri di approfondimento, di collegamenti ipertestuali espliciti al punto o

all'elemento corrispondente nel testo principale.

 Evitare di utilizzare immagini o altri elementi grafici per rappresentare contenuti

testuali.

* Dotare le immagini, i grafici e le tabelle di didascalie esaurienti, che forniscano
informazioni equivalenti commisurate alla funzione esercitata dall’oggetto originale

nello specifico contesto.

* Collegare esplicitamente le didascalie allimmaginea cui si riferiscono tramite

numerazione sequenziale contestualizzata all’organizzazione del documento.

» Garantire che i contenuti sottoposti a ingrandimento siano visualizzati nel rispetto
dellordine di presentazione originale ed evitare che per la loro lettura si debba

ricorrere alla barra di scorrimento orizzontale del programma di lettura utilizzato.



FUNZIONI PRINCIPALI PER CREARE PDF ACCESSIBILI CON ADOBE PRO

Rendere accessibile un documento PDF con Adobe significa:

creare file PDF con tag mediante applicazioni di creazione
convertire file PDF senza tag in PDF con tag

impostare le protezione che consentono l'accesso al testo da parte dei programmi
di lettura dello schermo, impedendo allo stesso tempo la copia, la stampa, la

modifica e l'estrazione di testo da parte degli utenti

aggiungere testo alle immagini acquisite mediante scansione per agevolarne

l'accesso

utilizzare strumenti per la modifica dell'ordine di lettura e della struttura del

documento

utilizzare strumenti per la creazione di moduli PDF accessibili

I modo migliore per verificare l'accessibilita di un documento & quello di provare ad

utilizzare il documento con gli strumenti che verranno utilizzati dagli utenti. Tuttavia, anche

se non di dispone di un programma di lettura dello schermo o di una stampante braille, &

possibile utilizzare le funzioni fornite da Acrobat per verificare I'accessibilita di un PDF tra

Cui:

la funzione di verifica rapida che verifica i tag della struttura del documento, il testo
ricercabile e le impostazioni di protezione adeguate per l'accessibilita. Questo
metodo rappresenta spesso la soluzione migliore per verificare I'accessibilita prima

di provare ad utilizzare un PDF.

la funzione di controllo completo che esegue una verifica piu approfondita di molte
caratteristiche dei PDF accessibili, quali l'utilizzo di font che possono essere

associati in modo affidabile a testo Unicode.

la vista Ridisponi che verifica rapidamente l'ordine di lettura.



* l'opzione Leggi a voce alta che verifica la fruizione del documento da parte degli

utenti che utilizzeranno questo strumento di sintesi vocale.

* lo strumento Ritocco ordine di lettura, la scheda Tag e la scheda Contenuto che

esaminano nel dettaglio la struttura, I'ordine di lettura e il contenuto di un PDF.

Per agevolare la lettura di file PDF Adobe mette a disposizione funzioni quali:

* Preferenze e comandi per ottimizzare I'output per software e periferiche di supporto,
ad esempio l'opzione di salvataggio dei dati come testo accessibile per stampante

braille

* Preferenze e comandi per agevolare la navigazione all'interno dei file PDF, ad
esempio le opzioni di scorrimento automatico e di apertura del PDF in

corrispondenza dell'ultima pagina letta

» L'Assistente Installazione accesso facilitato consente di impostare facilmente la

maggior parte delle preferenze legate all'accessibilita
» Alternative della tastiera alle azioni del mouse

* Funzionalita di ridisposizione per presentare temporaneamente il testo di un file

PDF in una singola colonna di facile lettura

« Comando per la sintesi vocale e la lettura a voce alta e supporto per programmi di

lettura e di ingrandimento dello schermo.

TEST DI VALUTAZIONE E CREAZIONE DI UN PDF ACCESSIBILE

Cerchiamo ora di comprendere in pratica quali sono gli step da compiere sul file PDF
2006-PR-09, Manuale del Sistema Puma (PUblication Management), Versione 1.0 per

I'amministratore, affinché esso diventi accessibile.

1) Verificare che il file PDF contenga testo e non immagine: se un pdf generato contiene
un'immagine, € necessario passarlo immediatamente a un OCR tramite il menu di Adobe
Document > OCR Text Recognition. Tale strumento permette di ottenere una versione
testuale che pud essere letta da uno screen reader.

Poiché il PDF 2006-PR-09 in esame contiene gia testo non sara necessario eseguire la



scansione OCR. Si mostra comunque di seguito I'operazione che l'utente avrebbe dovuto

compiere in caso contrario:

Fig. 1 - L'applicazione OCR in Adobe Pro Extended



2) Validare il PDF tramite il validatore di Acrobat dal menu Accessibility < Full Check .
Alla fine dell'analisi, il validatore produrra un report che evidenzia gli eventuali errori e
propone delle soluzioni. E possibile scegliere di visualizzare i risultati del controllo
completo dell'accessibilita in un file HTML oppure sotto forma di commenti posizionabili

all'interno del documento in cui sono stati rilevati i problemi di accessibilita.

Fig. 2 — Lo strumento Full Check in Adobe Pro Extended



3) Aggiungere tag al documento selezionando Advanced > Accessibility > Add Tags to
Document. | motore di inferenza di Acrobat cerca di desumere i tag adatti analizzando le
caratteristiche dei paragrafi presenti nel documento. Al termine del processo, al file PDF
sono stati applicati i tag necessari e, se vengono rilevati eventuali problemi, nel pannello di

navigazione viene visualizzato il Rapporto aggiunta tag.

Fig. 3 — Lo strumento Add Tags to Document in Adobe Pro Extended



4) Dove necessario editare i tag per migliorare I'accessibilita selezionando il menu View >
Navigation Panel > Tags. Da qui si puo osservare e intervenire sulla struttura del PDF
con la massima precisione. || menu Options contiene una voce molto importante:
Content. Questo pannello mostra le singole pagine del PDF, ed & possibile accedere alla
struttura di ciascuna pagina facendo clic sul pulsante di espansione +. Attivandola, il clic
sull'elemento nel tree produrra l'evidenziazione dell'elemento corrispondente nel PDF con
evidente vantaggio durante l'editing. Il pannello Tag accanto a Content, come gia
anticipato, permette di cambiare la natura del tag qualora la conversione non sia riuscita
pienamente (clic destro sul tag da modificare, selezionare Properties nel menu
contestuale), di creare nuovi tag e di modificare le caratteristiche del tag (per esempio, per

aggiungere il testo alternativo alle immagini).

Fig. 4 — Il pannello Tags e il menu Options in Adobe Pro Extended



5) Usare il pannello se necessario variare l'ordine di lettura del documento. Se il layout
complesso, per esempio su piu colonne strette, il riconoscimento automatico puo fallire,
con risultati disastrosi. Per esempio, le colonne potrebbero essere lette come se si
trattasse di testo affiancato, ovvero prima riga prima colonna, prima riga seconda colonna
e cosi via, rendendo del tutto incomprensibile la lettura. Quindi il pannello Order, che
permette di intervenire sulla struttura di ciascuna pagina. A tale scopo, selezionare la voce
TouchUp Reading Order nel menu Options. Questo strumento consente inoltre di
aggiungere testo alternativo alle immagini e di correggere molti tipi di problemi di tag

definiti nel rapporto generato da Acrobat quando si aggiungono tag ad un PDF.

Fig. 5 — Il pannelo Order e TouchUp Reading Order in Adobe Pro Extended



6) Inserire alternative testuali alle immagini: per consentire ai programmi di lettura dello
schermo di descrivere elementi grafici che illustrano concetti importanti in un documento,
occorre fornire la descrizione utilizzando testo alternativo. Infatti le figure non vengono
riconosciute da un programma di lettura dello schermo, a meno che non si aggiunga testo
alternativo alle proprieta dei tag. Per far cid cliccare con il tasto destro sul tag da

modificare e selezionare Properties, quindi digitare il testo alternativo.

Fig. 6 — Inserimento di testo alternativo ad un'immagine in Adobe Pro Extended



Fig. 7 — Risultato dell'inserimento del testo alternativo sulla figura 1 e 4



7) Aggiungere Segnalibri: un'utile caratteristica per navigare i file PDF & rappresentata dal
pannello Segnalibri (View > Navigation Panel > Bookmarks). Se il documento € stato
creato in origine rispettando le giuste regole strutturali, la creazione dei segnalibri sara
stata automatica. Nel nostro caso la ricreiamo invece dopo aver verificato la struttura nel
PDF semplicemente selezionando New Bookmark della struttura nel menu Options del
pannello Bookmarks, che permette anche di aggiungere, togliere, editare i segnalibri
necessari (detto pannello & accessibile alla lettura anche utilizzando uno screen reader)

oppure, come nell'esempio, semplicemente selezionando Document < Add Bookmark.

Fig. 8 — Inserimento di un segnalibro in Adobe Pro Extended



Fig. 9 — Risultato dell'inserimento del segnalibro Indice e Home Page all'interno del documento



8) Indicare la lingua del documento: questo pud essere fatto nella finestra di dialogo
Properties del documento (File > Properties), scheda Advanced. In questa stessa
finestra di dialogo possono essere impostate diverse caratteristiche del PDF, fra cui le

opzioni di sicurezza e di apertura del file.

Fig. 10 — Selezione della lingua del documento in Adobe Pro Extended



9) Ridurre il peso di un PDF: la dimensione di un file PDF a cui viene aggiunta struttura
pud velocemente aumentare. E quindi importante usare le opzioni di riduzione del peso
dei PDF rese disponibili da Acrobat. Selezionare Advanced > PDF Optimizer. La finestra
di dialogo che comparira permette di ridurre decisamente il peso del file, intervenendo

sugli elementi che di solito lo appesantiscono (immagini, font, elementi duplicati).

Fig. 11 — Lo strumento PDF Optimizer in Adobe Pro Extended



10) Ridurre le dimensioni del file, selezionando Document > Reduce File Size e
selezionando un formato precedente si elimineranno dal PDF tutte quelle caratteristiche di

solito inutili nei documenti di testo. A questo punto il nostro documento PDF risultera

perfettamente accessibile.

Fig. 12 — Lo strumento Reduce File Size in Adobe Pro Extended



	NORMATIVA ITALIANA
	Per agevolare la lettura di file PDF Adobe mette a disposizione funzioni quali:


